M 1071 ANNUAL

SedonaOffice [INA Y HUIFaNE [0z
e @ O Q

LEARN NETWORK ACHIEVE

SedonaSync — Where to Find
Answers

Presented By:

Matt Howe and Bridget Perea




2014 SedonaOffice Users Conference SedonaSync - Where To Find the Answers
Marco Island, Florida Presented By: Matt Howe and Bridget Perea

Table of Contents

Working Within SEAONASYNC .....cceeeiiiiciriiccrriccrrccrreeeerrneeesrens e senaseessensssseensssseenssssennsnnnns 3
How to check on the Status 0f aN EVENT..... sttt sssss s sesssss s ssssesans 3
Stopping SedonaSync from sending OUL €MAILS ......oereerrieneernenece e ess s ss s sssses s sssesasebsssanes 4
INSEALl AN EVENTPAK ..ottt sttt sss st ss s bbb bR R ARkt 5
SedonaOffice Data StrUCtUre .........cceviiiimmnnnettiiiiiitrrree e 11
DAtADASE EXPLOTET ..cccereueeiiureieeesse e isetsesseesssessessseesse s s bbb b8 s R 4R R e bbb R 11
CUSTOMET QUETY BUILAET .ottt ettt esees s s bbb s s s s s bbb s 13
Y] < o ]« T 18
Setting UP @ StAaNAard SUDSCIIDET ...ttt ts s ss e bbb s ss s st 19
Including Advanced Subscriber from Sedona0ffiCe. ..o sess e sssssssesseranes 21
BIll O fOT A SPECIFIC INMVOICE ....coureverrerereseerisseriseseas s esissesissssssss s s e sss s s st s s sb st s st ras 26
SAIESPETSON fOI (A CUSLOMME .courvverevvererrerserssssesassesessasassssasssessssssassssessssssssssssssssssesassssassssssssesssssssssssesssssssssssssssassessnsssssssssssses 27
SAIESPETSON fOI A JOD oreerreeereeeetrisetrises st s sesissssis s ssessssesas s sS850 0 4855kt R 1108 27
PTOJECt MANAGET fOI A JOD oottt esase s s sssss s esasss s s st s st 27
Last teCANICIAN ON A SCIVICE LICKETL .....oeureereerseerereresseassesssesssssassssssesssesssssassssssessssssssssssssssesssssssssassesssssssesssssassssssesssesssssens 28
FOrmatting RESUILS ...cceuuiieiiiiiiiiiieiccrtiscereneeereneeerenesesenssessensssssenssessennssssensssssennssssennsnnnes 28
QUETY — CalCULALEA COLUMIS. ...ceuieureeureeeeeeeeseesseeeseeseessesssesssessse s s e s s s s s s e s s bbb s nb s 28
EVENT = EIMAIL ettt ca st es s s d R R R e e e s s 34
Inserting a table iNto the DOAY Of AN @MAIL ...t esesssesissesissssis s s essssssassssssssssssessssesassssanes 34
INSErting a liNK fOr SEAONAWED ......cuveeeeerereereereeserseersesris s essssesassssassssasssesssesassssassssesssssssssssssssasssssssssssssssassssasssanns 35
DB R =2 T e B L0 Lo T O O O OO OOOOP 35
. ®
SedonaOffice Page 20135

The #1 Financial Software for Security Companies



2014 SedonaOffice Users Conference
Marco Island, Florida

SedonaSync - Where To Find the Answers
Presented By: Matt Howe and Bridget Perea

Working within SedonaSync

How to check on the status of an Event
You can use the SedonaSync Monitor to check on the status of an event.

[ ] %
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Stopping SedonaSync from sending out emails

Step 1. Stop the SedonaSync Service

On the server where SedonaSync is installed, go to Control Panel > Administrative Tools >
Services >

Depending on your installation, look for KnowledgeSync or SedonaSync

File Action View Help
s | E Bz HE >»®nn

L. Services (Local) ? Services (Local)

A

KnowledgeSync Name Description Status Startup Type Log On As
) % Hyper-V Virtual Machine M... Manageme... Running  Automatic Local Syste...
ﬁt;:es::iece % Hyper-V Volume Shadow C... Coordinates... Manual (Trig... Local Syste...
Restart the service 5 IKE and AuthlP IPsec Keying... The IKEEXT ... Running Automatic (T... Local Syste...
o % Intel(R) Capability Licensing... Version: 1.2... Running  Automatic Local Syste...
% Intel(R) Capability Licensing... Version: 1.2... Manual Local Syste...
% Intel(R) Content Protection ... Intel(R) Con... Manual Local Syste...
% Intel(R) Dynamic Applicatio... Intel(R) Dyn... Running Automatic Local Syste...

%4 Intel(R) Management and S...  Allows appli... Running  Automatic (D... Local Syste...
5 Intel(R) Management and S... Intel(R) Ma... Running  Automatic (D... Local Syste...
L Intel(R) Rapid Storage Tech... Providessto.. Running Automatic (D.. Local Syste...

4 Interactive Services Detection Enables use... Manual Local Syste...
% Internet Connection Sharin... Provides ne... Disabled Local Syste...
54 IP Helper Providestu.. Running  Automatic Local Syste...
% IPsec Policy Agent Internet Pro...  Running  Manual (Trig... Network S...
g ovledgesyne ______________Running _Automatic __Local Syste..|
%, KtmRm for Distributed Tran... Coordinates... Manual (Trig... Network S...
% Link-Layer Topology Discov... Creates a N... Manual Local Service
% Local Session Manager Core Windo... Running  Automatic Local Syste...
% Microsoft Account Sign-in ... Enables use... Manual (Trig... Local Syste...

s Lo iCAC) i © La L La 1 ! 1

Right click on it and select Stop. This will stop SedonaSync from processing any events or
emails until it is restarted. Keep this screen open as you will have to come back here in a
future step.

Step 2. Review the list of pending emails in the Monitor. Make sure there are not any
emails that should be sent. If there are, you might need to run the event again so they get
processed.

Step 3. Remove pending items
In SedonaSync Administrator, go to File > Database Tools > Remove Pending Items. Select
Email Pending and click Remove. This will delete all pending emails.
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You are about to remove pending items.

Please check the types of items to remove.

[ Actions Pending [~ IM Pending

[~ Application Events Pending [~ Pages Pending

[~ Reports Pending

[ Faxes Pending [~ Webcast Pending

™ File Deliveries Pending

Remove | Cancel |

A message will display asking if you are sure you want to do this. If you select yes, a second
message will display how many pending items were removed.

Step 4. Restart the service
Go back to the Services screen. Right click on KnowledgeSync or SedonaSync. Select Start.

Install an EventPak
To install an Event Pak open KnowledgeSync Event Manager. Go to File > EventPak >
Install. Select to the EventPak you wish to install and click Open.

SedonaOffice Page 5 of 35
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T . « KnowledgeSy... » Event Packs Created v ¢ Search Event Packs Created

Organize v New folder

\ . ol
X Favorites Name Date modified

B Desktop I(f] Event Pak UsersConference 2014.kse 1/8/201410:24 PM  KnowledgeSyncE...
& Downloads {f’ Event Pak Format Business Name.kse 5/8/2013 3:25 PM KnowledgeSync E...
2l Recent places {f’ Event Pak Format Phone.kse 5/8/2013 3:24 PM KnowledgeSync E...

4 Libraries
@ Documents

J’ Music

[ Pictures

B videos

+& Homegroup

'8 Computer v <

File name: | Event Pak UsersConference 2014.kse v ] ‘ EventPaks (*.kse)

| Open |v| ’ Cancel

The KnowledgeSync - EventPak Installation will tell you what applications will be created
by installing this EventPak.
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EventPak Description:
Company:
Sales Contact Name:
Sales Phone Number:
Sales Email Address:
Sales Website Address: |h
EventPak Version: [{.p

EventPak Release Date: |-

Installation Notes:

H =l s o e s
nEiallation notes are nere

The following Application(s) will be installed into the Database
Application Destination Folder/Application (Click for dropdown list)
e =e o g e R R S el ) | Install as new application into folder-> Application Events

Install Cancel

Click Install. The installation takes seconds. When it is complete, Finished! will appear
next to the Install button.
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EventPak Description: |

Company: |Know|edge5_vnc EventPak Builder Name

Sales Contact Name: |Sa|es Contact Name

Sales Phone Number: |

Sales Email Address: |

Sales Website Address: |http:/Awww.yoursite.com

EventPak Version: |1 0

EventPak Release Date: |1 7822014

Installation Notes:

|Installation notes are here

The following Application(s) will be installed into the Database
Application Destination Folder/Application (Click for dropdown list)
Sedonalffice - Users Conference 2014 | Install as new application into folder-> Application Events

Finished!

Install

Click the Close button. Event Manager will need to refresh the list of applications. Once the
Event Manager reopens, your new application will be added to the tree structure on the
left. You will need to select the application name and click the Properties button on the top
of the screen.
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| Eile View Help
HQPﬂnt l X Delete | 5! Properties

Application Events Email Response System
,,’J Event WatchDog
\’J Operating System Alerts
Ql Sample Application
@/ Sedonalffice - AR
{’J SedonaOffice - Format Name

| Sedonalffice - Format Phone
’] Sedonalffice - New C Invoices Detail
@/ Sedonalffice - New Invoices
Q] Sedonalffice - OE
1’] Sedonalffice - SV
QJ SedonaOffice - SY

Sedonalffice - Users Conference 2014

| Testing
-8 Subscribers

You will have to complete all of the connection information for the new application. This
will also have to be done anytime you create a new application.
Select the correct Connection to Use For Database Access and click Edit Connections...

Description: [5edonalffice - Users Conference 2014

Connection to Use For Database Access:

Sedonalffice ;I Edit Connection...

New Connection...

Cancel

SedonaOfflce Page 9 of 35
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Select an ODBC if one is not already selected and enter the Username of SedonaReports.
Password will be left blank for this user. Click the Save and Close button.

File Edit Help

[ save and Close ‘ X Delete

Connection Description: Sedonalffice

General T History ]

Internal ID humber: |30 SedonaSandbox

Connection Description: |Sedonanfice

ODBC Data Source Name [DSN): |Sedona8andbox

Usemame: |SedonaReportsl

Password: |

Date Separation Character: ['_ Use Coordinated Universal Time (UTC) for Date/Times I~
Long Tablename LEFT Character: I'_ Link Aloin prefix (Optional): I'—
Long Tablename RIGHT Character: Link Aloin suffix (0 ptional): I'—
Column Alias Character: I'"_
v Retrieve Database Owner with objects if available.

[~ Remove parentheses from Link/Joins

Script APl Name:

Script APl Usermname:

Script APl Password:

If you do not update the connection information you will receive an error message similar
to the following when you try to edit a query.

SedonaOffice’ Page 10 of 35

The #1 Fi i for Security Comp




2014 SedonaOffice Users Conference SedonaSync - Where To Find the Answers
Marco Island, Florida Presented By: Matt Howe and Bridget Perea

Error connecting to application using ODBC:40002 IM002: [Microsoft][ODBC
Driver Manager] Data source name not found and no default driver specified
(ODBC Data Source Name (DSN)=SedcnaSync ; Username=)

Query Save, Update and preview will be unavailable until connection information
is corrected or application becomes available.

SedonaOffice Data Structure

Database Explorer

On our website under downloads is the database explorer. This is a tool to help you with
our table structure. It can be found under the following link as 5.6 Database Explorer.
http://www.sedonaoffice.com/resources/downloads/

Download 5.6 Database Explorer. You will have to extract the files on a computer that has
SedonaOffice installed on it.

Double click on dbExplorer.exe.

Tables Linked To T Search and Print

Table IType I Size ILink to
AP_Check
AP_Check_Expense
AP_Check_Invoices
AP_Check_Parts
AP_Company_Aging
AP_Credit
AP_Credit_Detail
AP_Credit_Expense
AP_Credit_Parts
AP_Invoice
AP_Invoice_Expense
AP_Invoice_Parts
AP_Purchase_Order
AP_Purchase_Order_Expense
AP_Purchase_Order_Parts
AP_Recurring

AP_Setup
AP_Setup_Userdef
AP_Shipping_Method
AP_Userdef_1
AP_Userdef_2
AP_Userdef_3

AP _Vendor
AP_Vendor_Accounts
AP_Vendor_Notes
AP_Vendor_Type

SedonaOffice’ Page 11 of 35
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Tables T Views T Linked To T Search and Print
Group | | Table | A || Name Type Size | Link to A
AP AR_Company_RMR Customer |d int 4
AR AR_Company_Setup Customer_Number varchar 15
cs AR_Contract_Form Customer_Status_ld int 4 S5_Customer_Status
FR AR_Credit Customer_Type_ld int 4 AR_Type_0Of_Customer
GE AR_Credit_suto Collection_Status_|d int 4 AR_Collection_Status
GL AR_Credit_Detail Dealer_Id int 4 AR_Dealer
IN AR_Credit_ltem Owned_By_Dealer_Id int 4 AR_Dealer
10 AR_Credit_[tem_Tax Salesperson_|d int 4 SY_Employee
0OE AR_Credit_Reason Temn_ld int 4 AR_Term
oP AR_Credit_Request Tax_Exempt_Num nvarchar 20
PR AR_Customer Blanket_PO nvarchar 20
PS AR_Customer_Aging Blanket_PO_E xpire smalldat... 4
ar AR_Customer_aging_lnvoice 0ld_Customer_Number nvarchar 15
SM AR_Customer_Aging_Retrodctive Total_AMR money 8
SO AR_Customer_Bank 0K_To_lncr_Date smalldat... 4
Ss AR_Customer_Bill No_Late_Fees nvarchar 1
Sy AR_Customer_Bill_&ging No_Statements nvarchar 1
Sy AR_Customer_CC Last_Statement_Date smalldat... 4
WS AR_Customer_Contact StatementBalance money 8
AR_Customer_EFT Print_Sites_On_Bills nvarchar 1
AR_Customer_E quipment Print_Statements nvarchar 1
AR_Customer_Group Print_Cycle_Invoices nvarchar 1
AR_Customer_|tem RollUp_Recuring char 1
AR_Customer_Late_Fees Customer_Since smalldat... 4
AR_Customer_Master_ltem Customer_Group_|d int 4 AR_Customer_Group
AR_Customer_Notes v | | Customer_Relation_|d int 4 AR_Customer_Relation v

Tables Linked To Search and Print

Table Name I Type I Size I Link to I A
AP_Check Customer_ld int 4

AP_Check_Expense Customer_Number varchar 15

AP_Check_Parts Customer_Status_|d int
AP_Credit_Expense Customer_Type_|d int
AP_Credit_Parts Collection_Status_Id int
AP_Invoice_Expense Dealer_Id int
AP_Invoice_Parts Owned_By Dealer_ld int
AP_Purchase_Order_Expense Salesperson_|d int
AR_ACH Tem_ld int
AR_Advance_Deposit Tax_Exempt_Num nvarchar
AR_Cancel_Queue Blanket_PO nvarchar
AR_Collection_Event Blanket_PO_Expire smalldat...
AR_Collection_Queue Old_Customer_Number nvarchar
AR_Credit Total_ RMR money
AR_Credit_suto 0K_To_lncr_Date smalldat...
AR_Credit_Request No_Late_Fees nvarchar
No_Statements nvarchar
AR_Customer_aging Last_Statement_Date smalldat...
AR_Customer_Aging_Retradctive StatementB alance money
AR_Customer_Bank Print_Sites_On_Bills nvarchar
AR_Customer_Bill Print_Statements nvarchar
AR_Customer_Bill_&aging Print_Cycle_Invoices nvarchar
AR_Customer_CC RollUp_Recuring char
AR_Customer_EFT Customer_Since smalldat...
AR_Customer_E quipment Customer_Group_ld int
AR_Customer_[tem Customer_Relation_ld int

S5_Customer_Status
AR_Type_0f_Customer
AR_Collection_Status
AR_Dealer

AR_Dealer
SY_Employee
AR_Term

n o
Rl == =T it ol ol

—_
o

AR_Customer_Group
AR_Customer_Relation

o g o b D fa = — g D
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Customer Query Builder
Build your query in the Customer Query Builder.

Customer Query Builder

El- Customer

- Customer_Number

- Customer_Name

- Customer_Name_2

- Customer_Status

- Customer_Type

- Customer_Salesperson

- Customer_Tax_Exempt

- Term

- Old_Customer_Number

- No_Late_Fees

- No_Collections

- Print_Statements

- Print_Sites_On_Bills

- Print_Cycle_Invoices
RollUup_Recurring

- Customer_Since

- Blanket_PO

- Blanket_PO_Expire

- Customer_OK_To_Incr_Di

- Last_Statement_Date

- Customer_Group_1

- Customer_Group_2

- Chain_Account

- Bill_Commercial

- Bill_Name

-~ Bill_Name_2

- Bill_Postal_Name

- Bill_Address_1

- Bill_Address_2

- Bill_City

< >

RMR as of:

i r— R

v

Fields to Display

Customer_Number
Customer_Name
Customer_Branch

Field

| Relation | Criteria

| And/Or |Sroup

Customer_Status

- = =]

And 1

Order By AD
Customer_Branch
Customer_Name

e

[~ Distinct rows

1 RI Criteria Rows: |50—

Te]

0 Rows Returned

—

vl 4> SQLl Clear | Open | Save | Export | Preview | Close |

Click the SQL button at the bottom of the screen to see the fields and tables used.

Select

AR_Customer.Customer_Number As ‘Customer_Number’,
AR_Customer.Customer_Name As ‘Customer_Name’,
brc.Branch_Code As "Customer_Branch’

From
AR_Customer

Inner JOIN AR_Branch brc On AR_Customer.Branch_ld =

brc.Branch_Id

Inner JOIN SS_Customer_Status On
AR_Customer.Customer_Status_Id =

SS_Customer_Status.Customer_Status_Id
Where
AR_Customer.Customer_Id <> 1 And
(Customer_Status_Code ="AR’)
Order By
brc.Branch_Code ASC,
AR_Customer.Customer_Name ASC

SedonaOffice’
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The part between Select and From is the Columns tab.

File Edit Help

[ save and Close ‘ i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  Customer Query Builder

Description| Tables| Links |Sorting| Filters| Sub Filters| SOL| Preview|
Available Columns to Query:

dbo.AR_Branch.Alternatetddress_Id Add Column to Query->
dbo.AR_Branch.Branch_Code
dbo.&R_Branch.Branch_ld Add Al Columns to Query->>
dbo.&R_Branch.Description
dbo.AR_Branch.GL_Code Add Calculated Column to Query...

Query Columns Selected
Column Name Selected Column Type | Customized Name Unique
dbo.AR_Customer. Customer_Id ... Normal Customer_|d
dbo.AR_Customer. Customer_MNumber MNormal Customer_Number
dbo.AR_Customer. Customer_MName MNormal Customer_MName
dbo.AR_Branch.Branch_Code MNormal Branch_Code

<-Remove Column from Query <<-Remove All Columns from Query

I~ Return DISTINCT Rows of Data Only

<< Back Next >> Cancel

Between From and Where will be your Tables and Links tabs.
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File Edit Help

[ save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description: Customer Query Builder

§|Links| Columns | Sorting| Filters| Sub Filters| SOL| Preview |
Available Tables:

dbo.Account_Period_Summary

dbo AllCredits Add Table ->
dbo.&AP_Check
dbo.AP_Check_Ex=pense
dbo.AP_Check_Invoices
dbo.AP_Check_Parts
dbo.AP_Company_Aging
dbo.AP_Credit
dbo.AP_Credit_Detail
dbo.AP_Credit_Expense
dbo.AP_Credit_Parts
dbo.AP_Invoice
dbo.AP_Invoice_Expense
dbo.AP_Invoice_Parts

Selected Tables:

dbo.AR_Branch
dbo.AR_Customer <-Remove Table
dbo.55_Customer_Status

<< Back Next >> Cancel

SedonaOffice’ Page 15 of 35
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File Edit Help
& save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description: Customer Query Builder

Add Table Link.. |

Tables Linked Together
Table Name Linked to Table Name | Column Name Linked to Column Name
dbo.&R_Customer dbo.AR_Branch dbo.AR_Customer.Branch_Id | dbo.AR_Branch.Branch_ld
dbo.AR_Customer dbo.55_Customer_Stat. | dbo.AR_Customer. Customer_¢ | dbo.55_Customer_Status.Cu

< |

[~ | would like to manually input the table linking.

<- Remove Link <<- Remove &ll Links

<< Back Next >> Cancel |

Between Where and Order By is the Filters tab.
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File Edit Help

[ save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next v

Query Description: Customer Query Builder

Available Columns to Filter:

dbo.AR_Branch.Alternatedddress_Id Add Column to Filter->
dbo.AR_Branch.Branch_Code

dbo.AR_Branch.Branch_|d Add All Columns to Filter->>
dbo.AR_Branch.Description

dbo.AR_Branch.GL_Code N Add Calculated Column to Filter..

Columns Selected for Filtering
Column Name Isorls | Operator Compare Value Type
dbo.AR_Customer.Customer_Id  |...] is not equal to 1 Number
dbo.SS_Customer_Status. Custorm is equal to AR Char

o] | ]

<-Remove Column from Filter | <<-Remove All Columns from Filtering | If Column Yalues Have Changed...

<< Back | Next >> | Cancel

After Order By is the Sort tab.

SedonaOffice’ Page 17 of 35
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File Edit Help

& save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  Customer Query Builder

i | Sub Fiters| SL| Preview|
Awailable Columns to Filter:

dbo.AR_Branch.Alternatedddress_Id Add Column to Filter->
dbo.AR_Branch.Branch_Code

dbo.AR_B lanch.Branc_h_.Id Add All Columns to Filter->>
dbo.&R_Branch.Description

dbo.AR_Branch.GL_Code N Add Calculated Column to Filter...

Columns Selected for Filtering
Column Name lsorls Operator Compare Value Type
dbo.AR_Customer. Customer_Id is nat equal to 1 MNumber
dbo.SS_Customer_Status. Custom is equal to AR Char

o] | ]

<-Remove Column from Filter | <<-Remove All Columns from Filtering | If Column Y alues Have Changed...

<< Back | Next >> | Cancel

Subscribers

There are two types of subscribers within SedonaSync.

Standard Subscriber - is one that you setup in SedonaSync. This subscriber has a static
email address that receives all records returned by the query.

Advanced Subscriber is one where the email address is returned as part of the data in your
query. The subscriber will only receive an email regarding records that the email address
is part of. An example would be the email address of the contact on a service ticket.

SedonaOffice’ Page 18 of 35
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Setting up a Standard Subscriber

In the Event Manager, expand Subscribers > Users. Users are categorized by Groups. Select
the appropriate Group and click Add User.

| Eile Edit View Help
“ﬁ New User | & print | X Delete | properties

Events
Subscribers

y&" Event Management Folders Subscribers\Users\Customer Service
Elg Application Events | Description
' Email Response System
Event WatchDog
Operating System Alerts
Sample Application
Sedonalffice - AR
Sedonalffice - Format Name
+ Sedona0ffice - Format Phone
o] "1 Sedonalffice - New C Invoices Detail
\’J SedonaOffice - New Invoices
o Sedonalffice - OF
SedonaDffice - SY

Sedonalffice - 5Y

SedonaSync

Ql Testing

=8 Subscribers
ﬁ Computers

-8 Users

Y Customer Senvice

#-_" ] Engineering

& Executive Team

& Finance

& Help Desk

& Human Resources

& Manufacturing

& Marketing

& Sales Team

Enter a Last Name and First Name. The Full Name and User Lookup Key will automatically
populate. Make sure Active is checked.
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File Edit Help

[ save and Close ‘ i Save and New ‘ X Delete ‘ 4 Previous

Subscriber Name:

Description |C0py| Emaill Faxl F'agel 'W'ebCastI InstantMessageI Subscriptionsl

Internal ID number: I

Last Name: |Perea

First Name: |Bridgel

Full Name: |Perea, Bridget
Job Title: |

Company Name: |
Phone Number: |
IP Address: |

Computer Name: |

User Lookup Key: |PEF{EAB

— History:

Item created by

Item created on

Item last changed by

Item last changed on

Nest >> Cancel

SedonaSync allows you to have more than one email address per Subscriber on the Email
tab. You can set up a schedule for which email address you want to use for specific times
and specific days of the week. As a best practice, | recommend entering Email Address1
and Email Address2. Even if they are both the same address. Ialso click the Use Address1
for All button. This will ensure that the first email address is always used. If both
addresses are the same, do not click Use Both for All. This will cause two emails to be sent
to the same address every time this Subscriber is on an Event.
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File Edit Help

& save and Close i Save and New ‘ X Delete ‘ 4

Subscriber Name:

Descriptionl Copy Email |Fax| Pagel ‘W'ebCastl Instant Messagel Subsc:iptionsl

Email AddressT: Isupport@sedonaofﬁce. com

Email Address2: Ilsupport@sedonaofﬁce.com

Please select which Email Address to use at the specified time:

1=Email Address 1, 2=Email Address 2, * = Bath, Space Bar for None

Segment| Sunday Monday Tuesday |Wednesday | Thursday Friday Saturday

12:00 AM 2 2 2 2 2 2

12:30 AM
1:00 AM
1:30 AM
2:00 AM
2:30 AM
3:.00 AM
3:30 AM
4:00 AM
4:30 AM
5:00 AM
5:30 AM
6:00 AM

PRI NN RN NN
PRI R NN RN N N NN
PRI NN IR R RN NN
PRI RN N RN N N N NN
PRI RN N RN N RN
PRI NN NN NN
PRI IR NN RN N R N N

Restore Defaults Use Address1 for All | Use Address2 for All | Use Both for &ll

<< Back Next >> | Cancel | Help

Including Advanced Subscriber from SedonaOffice

Customer’s primary bill to:

SELECT dbo.AR_Customer_Bill.Customer_Bill_Id AS "Customer_Bill_Id",
dbo.AR_Customer.Customer_Number AS "Customer_Number",
dbo.AR_Customer.Customer_Name AS "Customer_Name",
dbo.AR_Customer_Bill.LE_Mail AS "E_Mail2" FROM (dbo.AR_Customer LEFT OUTER
JOIN dbo.AR_Customer_Bill ON dbo.AR_Customer.Customer_Id =
dbo.AR_Customer_Bill.Customer_Id) WHERE dbo.AR_Customer_Bill.E_Mail LIKE
"%@%.%" AND dbo.AR_Customer_Bill.Is_Primary = 'Y' ORDER BY
dbo.AR_Customer_Bill.E_Mail ASC, dbo.AR_Customer.Customer_Number ASC
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File Edit Help

[ save and Close i Save and New l X Delete ‘ 4 Previous v W Next v

Query Description:  Primary Biling Address

Available Tables:

dbo.Account_Period_Summary

dbo AllCredits Add Table ->
dbo.AP_Check
dbo.AP_Check_Expense
dbo.AP_Check_Invoices
dbo.AP_Check_Parts
dbo.AP_Company_Aging
dbo.AP_Credit
dbo.AP_Credit_Detail
dbo.AP_Credit_Expense
dbo.AP_Credit_Parts
dbo.AP_Invoice
dbo.AP_Invoice_Expense
dbo.AP_Invoice_Parts

Selected Tables:

dbo.AR_Customer
dbo.AR_Customer_Bill <- Remove Table |

<< Back Next >> Cancel
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File Edit Help

& save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  Primary Biling Address

Description| Tables i :§|Columns| Sorting| Fiters| Sub Filters| SAL| Preview |

Add Table Link.. |

Tables Linked Together
Table Name Linked to Table Name | Column Name Linked to Column Name
dbo.AR_Customer dbo.AR_Customer_Bill | dbo.AR_Customer.Customer_| | dbo.AR_Customer_Bill. Custo

[« |

[~ | would like to manually input the table linking.

<- Remove Link <<- Remove &ll Links

<< Back Cancel
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File Edit Help

[ save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  Primary Biling Address

Available Columns to Query:

dbo.AR_Customer.Blanket_PO Add Column to Query->
dbo.AR_Customer.Blanket_PO_E =pire

dbo.&R_Customer.Branch_Id Add Al Columns to Query->>
dbo.AR_Customer.Collection_Status_|d

dbo.AR_Customer. Customer_Group_|d Add Calculated Column to Query...

Query Columns Selected
Column Mame Selected Column Type | Customized Name Unique
dbo.AR_Customer_Bill. Customer_Bill_Id MNormal Customer_Bill_Id
dbo.AR_Customer. Customer_MNumber MNormal Customer_MNumber
dbo.AR_Customer. Customer_MName MNormal Customer_MName
dbo.AR_Customer_Bill. E_Mail MNormal E_Mail2

<-Remove Column from Query <<-Remove All Columns from Query

I~ Return DISTINCT Rows of Data Only

<< Back Cancel
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File Edit Help

[& save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  Primary Biling Address

Available Columns for Sorting:

dbo.AR_Customer. Customer_Name )
dbo.AR_Customer. Customer_Number Add Column for Sorting->
dbo.AR_Customer_Bill. Customer_Bill_Id

dbo.AR_Customer_Bill E_Mail 4dd All Columns for Sorting->>

Columns Selected for Sorting
Column Name Sort Direction
dbo.AR_Customer_Bill.E_Mail Ascending
dbo.AR_Customer. Customer_MNumber Ascending

<-Remove Column from Sorting <<-Remove All Columns from Sorting |

<< Back | Cancel |
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File Edit Help

& save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  Primary Biling Address

Available Columns to Filter:

dbo.AR_Customer_Bill Address_1 Add Column to Filter->
dbo.AR_Customer_Bil.Address_2
dbo.AR_Customer_Bill Address_3 Add All Columns to Filter->>
dbo.AR_Customer_Bill.Branch_Id
dbo.AR_Customer_Bill. Business_MName v Add Calculated Column to Filter...

Columns Selected for Filtering

Column Name Isorls | Operator Compare Value Type
dbo.AR_Customer_Bill. E_Mail 1 I like Z@%.% Char
dbo.AR_Customer_Bill.ls_Primary is equal to Char

o] | ]

<-Remove Column from Filter | <<-Remove All Columns from Filtering | If Column Yalues Have Changed...

<< Back | Next >> | Cancel

Bill to for a specific invoice

SELECT dbo.AR_Customer_Bill.E_Mail AS "E_Mail", dbo.AR_Invoice.Invoice_Id AS
"Invoice_Id", dbo.AR_Invoice.Invoice_Number AS "Invoice_Number" FROM
(dbo.AR_Invoice LEFT OUTER JOIN dbo.AR_Customer_Bill ON
dbo.AR_Invoice.Customer_Bill_Id = dbo.AR_Customer_Bill.Customer_Bill_Id)
WHERE dbo.AR_Customer_Bill.E_Mail LIKE '%@%.%'
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Salesperson for a customer

SELECT dbo.AR_Customer.Customer_Id AS "Customer_Id",
dbo.AR_Customer.Customer_Number AS "Customer_Number",
dbo.AR_Customer.Customer Name AS "Customer_Name",
dbo.SY_Employee.UserCode AS "UserCode", dbo.SY_Users.EMail_Address AS
"EMail_Address" FROM ((dbo.AR_Customer LEFT OUTER JOIN dbo.SY_Employee ON
dbo.AR_Customer.Salesperson_Id = dbo.SY_Employee.Employee_Id) LEFT OUTER
JOIN dbo.SY_Users ON dbo.SY_Employee.User_Id = dbo.SY_Users.User_Id) ORDER
BY dbo.SY_Users.EMail_Address ASC, dbo.SY_Employee.UserCode ASC,
dbo.AR_Customer.Customer Number ASC

Salesperson for a job

SELECT dbo.OE_]Job.Job_Id AS "Job_Id", dbo.OE_Job.Job_Code AS "Job_Code",
dbo.OE_Job.Salesperson_Id AS "Salesperson_Id", dbo.SY_Employee.Employee_Code
AS "Employee_Code", dbo.SY_Users.EMail_Address AS "EMail_Address" FROM
((dbo.OE_Job LEFT OUTER JOIN dbo.SY_Employee ON dbo.OE_]Job.Salesperson_Id =
dbo.SY_Employee.Employee_Id) LEFT OUTER JOIN dbo.SY_Users ON
dbo.SY_Employee.User_Id = dbo.SY_Users.User_Id) WHERE
dbo.OE_Job.Salesperson_Id <> 1 ORDER BY dbo.SY_Users.EMail_Address ASC,
dbo.SY_Employee.Employee_Code ASC, dbo.OE_]Job.Job_Code ASC

Project Manager for a job

SELECT dbo.OE_]Job.Job_Id AS "Job_Id", dbo.OE_Job.Job_Code AS "Job_Code",
dbo.OE_]Job.Proj_Mgr_Id AS "Proj_Mgr_Id", dbo.SY_Employee.Employee_Code AS
"Employee_Code", dbo.SY_Users.EMail_Address AS "EMail_Address" FROM
((dbo.OE_Job LEFT OUTER JOIN dbo.SY_Employee ON dbo.OE_]Job.Proj_Mgr_Id =
dbo.SY_Employee.Employee_Id) LEFT OUTER JOIN dbo.SY_Users ON
dbo.SY_Employee.User_Id = dbo.SY_Users.User_Id) WHERE
dbo.OE_Job.Proj_Mgr_Id <> 1 ORDER BY dbo.SY_Users.EMail_Address ASC,
dbo.SY_Employee.Employee_Code ASC, dbo.OE_]Job.Job_Code ASC

Technician for an appointment on a service ticket
Assuming tech is an employee and not a vendor

SELECT dbo.SV_Service Ticket.Service_Ticket_Id AS "Service_Ticket_Id",
dbo.SV_Service_Ticket.Ticket_Number AS "Ticket_Number",
dbo.SY_Employee.Employee_Code AS "Employee_Code",

dbo.SY Users.EMail Address AS "EMail Address" FROM
((((dbo.SV_Service_Ticket_Dispatch LEFT OUTER JOIN dbo.SV_Service_Tech ON
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dbo.SV_Service_Ticket_Dispatch.Service_Tech_Id =
dbo.SV_Service_Tech.Service_Tech_Id) LEFT OUTER JOIN dbo.SY_Employee ON
dbo.SV_Service_Tech.Employee_ld = dbo.SY_Employee.Employee_Id) LEFT OUTER
JOIN dbo.SV_Service_Ticket ON dbo.SV_Service_Ticket_Dispatch.Service_Ticket_Id =
dbo.SV_Service_Ticket.Service_Ticket_Id) LEFT OUTER JOIN dbo.SY_Users ON
dbo.SY_Employee.User_Id = dbo.SY_Users.User_Id) ORDER BY

dbo.SY Users.EMail Address ASC, dbo.SV_Service Tech.Service_Tech_Id ASC,
dbo.SV_Service_Ticket_Dispatch.Schedule_Time ASC,

dbo.SV Service _Ticket.Ticket Number ASC

Last technician on a service ticket

SELECT dbo.SV_Service Ticket.Service_Ticket_Id AS "Service_Ticket_Id",
dbo.SV_Service_Ticket.Ticket_Number AS "Ticket_ Number",
dbo.SY_Employee.Employee_Code AS "Employee_Code",
dbo.SY_Users.EMail_Address AS "EMail_Address" FROM (((dbo.SV_Service_Ticket
LEFT OUTER JOIN dbo.SV_Service_Tech ON
dbo.SV_Service_Ticket.Last_Service_Tech_Id = dbo.SV_Service_Tech.Service_Tech_Id)
LEFT OUTER JOIN dbo.SY_Employee ON dbo.SV_Service_Tech.Employee_Id =
dbo.SY_Employee.Employee_Id) LEFT OUTER JOIN dbo.SY_Users ON
dbo.SY_Employee.User_Id = dbo.SY_Users.User_Id) ORDER BY

dbo.SY _Users.EMail Address ASC, dbo.SV_Service Tech.Service_Tech_Id ASC,
dbo.SV Service _Ticket.Ticket Number ASC

Formatting Results

Query — Calculated Columns

Within a query you can add conditional formatting to a field. In SedonaSync terms, this is a
Calculated Column. As an example, I am going to show you how to switch a customer’s
billing address name so it is first name last name instead of last name, first name.

On the Columns tab click the ‘Add Calculated Column to Query... button to add a new field.
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J KnowledgeSync - Application Events\SedonaOffice - Format Name\Query Definiti...
File Edit Help |

& save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~ ‘

Query Description: format name

Descriptionl Tablesl Links Columns |Sorting| Filtersl Sub Filtelsl SQLI Pteviewl
Available Columns to Query:

dbo.AR_Customer_Bill.Address_1

A~ Add Column to Query->
dbo.AR_Customer_Bill Address_2
dbo.AR_Customer_Bill.Address_3 Add Al Columns to Query->>
dbo.AR_Customer_Bill.Branch_Id
dbo.AR_Customer_Bill. Business_Name v

Add Calculated Column to Query...

BQuery Columns Selected

Column Name Selected Column Type | Customized Name Unique
P | dbo.AR_Customer_Bill. Customer_Bill_Id Normal Customer_Bill_Id 4

dbo.AR_Customer_Bill Business_Name Normal Business Name l_

dbo.AR_Customer_Bill. Commercial Normal Commercial l_

<-Remove Column from Query

<<-Remove All Columns from Query |

[~ Retun DISTINCT Rows of Data Only

<< Back | Next >> Cancel |

You can add any valid SQL statement to the Calculated Column Workbox.
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Double-Click on available columns and/or calculations to select or edit Workbox manually:

Calculations to perform (sqlserver):

CHARINDEX - Return the location of a string in a database column
CONVERT - Change date/time column to date only

CONVERT - Change date/time column to time only

CONVERT - Change date/time column to time only [Military]
CONVERT - Change string column to a number

CONVERT - Change number column to a string

CONVERT - Change currency column to a string

DATEADD - Add 1 hour to today's date

DATEADD - Add 30 minutes to today's date

Database Columns to use in calculation: Yariables to use in calculation:

dbo.AR_Customer_Bill &ddress_1 Z%Current Year’
dbo.AR_Customer_Bill.Address_2 Z%lLast Year%

dbo.AR_Customer_Bill &ddress_3 ZNext Year’
dbo.AR_Customer_Bill.Branch_Id Z%Current Date”,
dbo.AR_Customer_Bill. Business_MName Z%Current Date YYYY/MM/DDZ%
dbo.&R_Customer_Bill. Business Name_2 #%Current Date Time%
dbo.AR_Customer_Bill. Commercial Z%Current Time Military?
dbo.AR_Customer_Bill. Country_|d ZCurrent Time Military Max?%
dbo.AR_Customer_Bill. Customer_Bill_Id ZCurrent Time
dbo.AR_Customer_Bill. Customer_|d Vv | %Current Hour’z

Calculated Column Waorkbox:

Cancel

For this example | am adding the following code:

CASE dbo.AR_Customer_Bill.Commercial when 'Y' then

dbo.AR_Customer_Bill. Business_Name

else (CASE CHARINDEX(',", dbo.AR_Customer_Bill.Business_Name) WHEN 0 THEN
dbo.AR_Customer_Bill. Business_Name ELSE

LTRIM(RTRIM(RIGHT (dbo.AR_Customer_Bill.Business_Name,
LEN(dbo.AR_Customer_Bill.Business_Name) - CHARINDEX(',,
dbo.AR_Customer_Bill. Business_Name))))+"'"' +
LTRIM(LEFT(dbo.AR_Customer_Bill.Business_Name, CHARINDEX(',',
dbo.AR_Customer_Bill. Business_Name)-1)) END) END
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To edit an existing field click on the field name under Column Name Selected and then the
ellipse button that appears next to it.

File Edit Help

[ save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  format bill to phone number

Descriptionl Tablesl Links Columns ISortingl Filtersl Sub Filtersl SQL' Preview|
Available Columns to Query:

dbo.AR_Customer_Bill Address_1 Add Column to Query->
dbo.AR_Customer_Bil.Address_2
dbo.AR_Customer_Bill Address_3 Add Al Columns to Query->>
dbo.AR_Customer_Bill.Branch_Id
dbo.AR_Customer_Bill. Business_Name Add Calculated Column to Query...

Query Columns Selected
Column Name Selected Column Type | Customized Name Unique
dbo.AR_Customer_Bill. Customer_Bill_Id MNormal Customer_Bill_Id v
JCASE LEN[dbo.AR_Customer_Bill. Phone_1]|...| Normal Formatted_Phone |_
dbo.&R_Customer_Bill. Phone_1 MNormal Phone_1 |_

<-Remove Column from Query <<-Remove All Columns from Query |

I~ Retun DISTINCT Rows of Data Only

<< Back Next >> Cancel

This example shows you how to format phone numbers.
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Double-Click on available columns and/or calculations to select or edit Workbox manually:

Calculations to perform (sqlserver):

CHARINDEX - Return the location of a string in a database column
CONVERT - Change date/time column to date only

CONVERT - Change date/time column to time only

CONVERT - Change date/time column to time only [Military]
CONVERT - Change string column to a number

CONVERT - Change number column to a string

CONVERT - Change currency column to a string

DATEADD - Add 1 hour to today's date

DATEADD - Add 30 minutes to today's date

Database Columns to use in calculation: Yariables to use in calculation:

dbo.AR_Customer_Bill &ddress_1 Z%Current Year’
dbo.AR_Customer_Bill.Address_2 Z%lLast Year%
dbo.AR_Customer_Bill &ddress_3 ZNext Year’
dbo.AR_Customer_Bill.Branch_Id Z%Current Date”,
dbo.AR_Customer_Bill. Business_MName Z%Current Date YYYY/MM/DDZ%
dbo.&R_Customer_Bill. Business Name_2 #%Current Date Time%
dbo.AR_Customer_Bill. Commercial Z%Current Time Military?
dbo.AR_Customer_Bill. Country_|d ZCurrent Time Military Max?%
dbo.AR_Customer_Bill. Customer_Bill_Id ZCurrent Time
dbo.AR_Customer_Bill. Customer_|d Vv | %Current Hour’z

Calculated Column Waorkbox:

[CASE LEN(dbo.AR_Customer_Bill.Phone_1) WHEN 10 THEN (' + LEFT[dbo.AR_Customer_Bil.Phone_1, 3] + )
'+ RIGHT(LEFT(dbo.&R_Customer_Bil.Phone_1, 6], 3] + ' + RIGHT [dbo.AR_Customer_Bil.Phone_1, 4 WHEN
7 THEN LEFT(dbo.AR_Customer_Bill.Phone_1, 3] + ' + RIGHT [dbo.AR_Customer_Bill.Phone_1, 4] ELSE
dbo.&R_Customer_Bil.Phone_1 END]

Cancel

It uses the following code to format phone number of 7 or 10 digits.

(CASE LEN(dbo.AR_Customer_Bill.Phone_1) WHEN 10 THEN '(" +
LEFT(dbo.AR_Customer_Bill.Phone_1,3) +") ' +
RIGHT(LEFT(dbo.AR_Customer_Bill.Phone_1, 6), 3) +'-' +
RIGHT(dbo.AR_Customer_Bill.Phone_1, 4) WHEN 7 THEN
LEFT(dbo.AR_Customer_Bill.Phone_1, 3) +'-' +
RIGHT(dbo.AR_Customer_Bill.Phone_1, 4) ELSE dbo.AR_Customer_Bill.Phone_1
END)

When you are done with the code, click OK and Save and Close the query.
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As a best practice [ keep the original field and my formatted field in the query. I can then
preview the query to see if [ get the desired results.

File Edit Help

[ save and Close i Save and New ‘ X Delete ‘ 4 Previous v W Next ~

Query Description:  format bill to phone number

format bill to phone number
Customer_Bill_|d|Formatted Phone  [Phone 1 -
| 4 1 [
8|(440) 247-5602 4402475602 T
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Event — Email

Inserting a table into the body of an email

{BEGIN*HTML}

<p>This would be a paragraph briefly explaining what data is in the email. This email
includes a table with four columns. When you see th - that is the table header. Columnl,
Column2, Column3 and Column4 represent the names of each column that will display in
your email exactly as you type them. When you see td - that is the table detail. (Field1},
{Field2}, {Field3}, and {Field4} represent fields from your query that you will insert into
each row. </p>

<p>If you want your table to contain multiple records for your query, you will need to
include {BEGIN*REPEAT} and {END*REPEAT} within your email. Any text that appears
between those two tags will be repeated once for each record in your query. </p>

<table width="100%">
<thead>
<tr>
<th width="40%" align="left">Column1</th>
<th width="20%" align="left">Column2</th>
<th width="20%" align="left">Column3</th>
<th width="20%" align="left">Column4</th>
</tr>
</thead>
<tbody>
{BEGIN*REPEAT}
<tr>
<td>{Field1}</td>
<td>{Field2}</td>
<td>{Field3}</td>
<td>{Field4}</td>
</tr>
{END*REPEAT}
</tbody>
</table>
{END*HTML}
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Inserting a link for SedonaWeb

In Event Manager, open an event and go to the Email tab. In the Message Text you will add
<a href="www.SampleCompany.com">MyWebsite</a>

The first portion in quotes “www.SampleCompany.com” is the actual website you want the

person to be directed to. The portion between the tags, “MyWebsite”, is the wording for the
link to click on.

Inserting a logo
In Event Manager, open an event and go to the Email tab. In the Message Text you will add:
<img src="http://www.SampleCompany.com/img/SampleGraphic.gif" alt="bluebar" />

The first portion in quotes after img src= is the path and name of the file that exists on the
Internet. The portion after alt= is the alternate text for an image if it cannot be displayed.
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